
Symbol Origin Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("planning symbol high",0,`NOT_FOUND')} {button How To,AL("define symbol origin 
how",0,`NOT_FOUND')}

Defines the origin of the symbol that you are creating. The origin of the symbol is the point that the mouse cursor 
uses to place the symbol in a document. When you click Symbol Origin, the symbol origin appears where it was
originally placed. You can then click any position or key point on an element to define the origin.



Place/Edit Connect Points Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("symbol authoring high",0,`NOT_FOUND')} {button How To,AL("place connect points 
how;edit connect points how",0,`NOT_FOUND')}

Places connect points on a symbol. Connect points are points at which a connector attaches to a symbol. You 
can place connect points in free space on any part of the document or on an element.

When you attach a connector to symbol with a connect point, the connector automatically attaches to the point at
the angle in radians that you set in the connect point's attributes. For example, you can place a connect point 
with an angle value of 1.5708 radians, or pi divided by two. Then, the connector automatically attaches to the 
connect point at an angle of 1.5708 radians.
Tip    You can attach connectors to symbols with the Connector button on the Draw or Schematic toolbar. 

Place/Edit Connect Points Dialog Box



Symbol Properties Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("symbol authoring high",0,`NOT_FOUND')} {button How To,AL("define symbol 
properties how",0,`NOT_FOUND')}

Allows you to define properties for a symbol. These properties can include the following items:
A special Help document for the symbol,                          
The types of handles the symbol displays, 
Special custom macros that execute when you drag the symbol,
Custom behaviors that occur when you place the symbol in a document.

Define Symbol Properties Dialog Box



Symbol Representation Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("symbol authoring high",0,`NOT_FOUND')} {button How To,AL("define symbol 
representation how",0,`NOT_FOUND')}

Defines different representations of the same symbol within one symbol document (.sym). The names of the 
representations that you define appear on the shortcut menu for the symbol when you drag the symbol into a 
document. When you click the name of the representation, the symbol changes to display the elements that you 
included in the representation. 

For example, you can define different representations of a valve with different types of actuators. When you drag 
the symbol into the document, you can choose which valve that you want to display from the shortcut menu.

 

Define Symbol Representation Dialog Box



SmartText Editor Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("symbol authoring high",0,`NOT_FOUND')} {button How To,AL("define text attributes 
for symbol how",0,`NOT_FOUND')}

Allows you to place Smart Text in a Smart Label. Smart Text allows a Smart Label to assume the text attributes of
an element to which the Smart Label is associated.

SmartText Editor Dialog Box



Place/Edit Drag Points Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("symbol authoring high",0,`NOT_FOUND')} {button How To,AL("place drag points 
how;edit drag points how",0,`NOT_FOUND')}

Places drag points on a symbol. A drag point is the point to which the mouse cursor attaches for dragging and 
dropping a symbol. You can also edit existing drag points with this command.

Place/Edit Drag Points Dialog Box



Place/Edit Drop Points Command (Symbol Authoring Tools Toolbar)
{button Related Topics,AL("symbol authoring high",0,`NOT_FOUND')} {button How To,AL("place drop points 
how;edit drop points how",0,`NOT_FOUND')}

Places drop points on a symbol. You can also edit existing drop points with this command.

When you click a drag point on a symbol and drag it over another symbol, the drop points appear as red dots. A 
bull's eye appears when the drag point and drop point are exactly aligned. You can then attach the symbol to the 
other with precision.

Place/Edit Drop Points Dialog Box



Managing Text in Symbols
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("define text attributes for symbol how;define text driven symbol how",0,`NOT_FOUND')}

You can add text to symbols by creating text boxes and balloons, placing text labels, or creating Smart Labels 
with Smart Text. Smart Text defines the text attributes for the symbol.

A label with Smart Text attributes is intelligent: Smart Labels with Smart Text read and write properties from an 
element or object. A label with Smart Text can assume the attributes of an element if the attributes for the 
element have the same name. Users can then edit the values of the text attributes in the Attribute Viewer. 
Users cannot change the names of the attributes.

Not all labels assume the text attributes of an element or object. Some labels contain shapes that grow 
automatically if you add text to the label. These are called text-driven symbols.



Planning Your Symbol
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("symbol authoring how",0,`NOT_FOUND')}

After you have determined the need for a symbol, you need to decide how you want that symbol to behave. The 
goal is to create a symbol that acts the way a user expects it to. .

When you create a symbol, it displays the following default behaviors:
90 degree rotation angles 
Automatic alignment with a target element or object when the symbol is placed in a document
Automatic association with a target element or object. 

Tip    You can change these default behaviors with commands on the Symbol Authoring Tools toolbar

Checklist for Consideration

When planning your symbol, the first item to consider is what happens when you add text to a symbol. Do you 
want to add text to the shape? If so, you should consider the position and appearance of labels, text boxes, or 
balloons. A Smart Label can be associated with attributes that you define. You can also define symbols that 
resize as a user adds text to the symbol.

The second item you should consider is what template will you want to use with the symbol. The scale of the 
template affects how the symbol looks when it is dragged in from the Symbol Explorer.

The next item for you to decide is what happens when you manipulate the symbol. Should the symbol size, 
mirror, flip, and rotate freely? Do you want the symbol to move with an element? You can set different options on 
the Define Symbol Properties dialog box. You can create special points on a symbol to determine how the 
symbol attaches to connectors, other symbols, or elements in a document. 

How smart should you make the symbol? You can create symbols that have text and parametric attributes. You 
can create text attributes using SmartText by clicking the SmartText button on the Symbol Authoring Tools 
toolbar. You can create parametric attributes by adding driving dimensions to the symbol and then adding the 
dimensions to the Parameters tab on the Define Symbol Properties dialog box.

Do you want users to access special programs when they drop a symbol or drag it? You can set options for these
and more on the Define Symbol Properties dialog box.

Do you want users to choose from a list of representations for the same symbol? You can accomplish this by 
clicking the Symbol Representation button on the Symbol Authoring Tools toolbar.

Tips for Developing Your Symbol

Developing your symbol in an orderly, thoughtful fashion saves you time in the long run. You can consider the 
following suggestions:

Make notes on what you want the symbol to do. What are your requirements? If the symbol is to be part of a
larger set, define the common requirements for the entire set first.                        

Draw a preliminary version of the symbol and format it to look the way you want. Experiment with it. What 
behaviors do you want when the symbol is rotated or scaled?

If you want to add parametric attributes, experiment with different formulas in the Variable Table. Create 
one formula at a time and test its effect on the symbol. Keep notes as you go. You might want to copy the symbol 
each time you try a new formula to keep a record of your experimentation.

You should test the symbol for usability by allowing a coworker to play around with the symbol. Does the 
symbol meet the coworker's expectations?

After you have considered all of these items, you should recreate the symbol from scratch. This is the best way 
to ensure that the symbol contains no obsolete parameters, attributes, or other behaviors that would clutter the 
symbol or increase its size.



Using Blank Color and Fill with Symbols 
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("fill symbol how",0,`NOT_FOUND')}

Symbols are actually groups of graphic elements with defined behaviors and properties that are saved in an .sym
document. You can enhance a symbol's display and performance during symbol design and creation. 
Incorporating a fill with blank color into the symbol allows the symbol, when placed, to mask out elements such 
as lines or connectors that intersect the symbol. This gives the appearance that the underlying lines have been 
broken at the edges of the symbol. In reality, the lines still exist beneath the symbol.

You can apply a fill to any closed boundary. Placing many fills in a document can significantly increase the size of
the document. A single fill can be used for the symbol by filling an area that represents the outer edges of the 
symbol and displaying the detailed graphic linework on top of the fill. 

The blank color can be used with any graphic object besides fill, so experiment and you might find other uses for 
this masking capability. .



Controlling How Symbols Expand
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("define text driven symbol how;create parametric symbol how",0,`NOT_FOUND')}

You can create symbols that shrink and grow when you enter text. You can also determine how users can resize 
a symbol by specifying parametric handles or scale handles. Symbols with these types of handles are parametric
symbols. You can define parameters with the tools on the Symbol Authoring Tools toolbar. ..



Integrating Programs with Your Symbol
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("run program from symbol how;define shortcut menu for symbol how",0,`NOT_FOUND')}

You can kick off special processes from your symbol when a user performs an particular action, such as double-
clicking the symbol, dragging it, or even modifying the symbol. The special process can be a .DLL, .OCX, 
or .EXE file that you created in other programming software. You can select an action from the Standard 
Actions tab on the Define Symbol Properties dialog box. 

You can also specify special processes that you can execute when you select a symbol, click the right mouse 
button, and then click a custom command on the shortcut menu. The command names of the processes that you
define appear at the top of the shortcut menu. You define these processes on the Custom Actions tab of the 
Define Symbol Properties dialog box.



Controlling Display Properties
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("define symbol properties how",0,`NOT_FOUND')}

You can control display properties for symbols in various ways. You can change the properties of various 
elements in the shape by applying styles or setting options such as line weight and color on the ribbon bar. You 
can also determine what handles appear on the symbol by setting options on the Define Symbol Properties 
dialog box.

On this dialog box, you can also set options for how the symbol displays when a user drags it into the document. 
For example, if you want the symbol to display as separate elements, and not a unified symbol, you can click the 
Discrete Objects option on the Behaviors tab of the Define Symbol Properties dialog box.



Controlling Connectors for Symbols
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("place connect points how;edit connect points how",0,`NOT_FOUND')}

Connect points allow you to determine how a connector line attaches to a symbol. You can define and remove 
connect points with the Place/Edit Connect Points button on the Symbol Authoring Tools toolbar.

You can specify the angle at which a connector attaches to a symbol. When you attach a connector to a symbol 
with a connect point, the connector automatically attaches to the point at the angle in radians that you set in the 
attributes of the connect point. For example, you can place a connect point with an angle value of 1.5708 
radians, or pi divided by two. Then, the connector automatically attaches to the connect point at an angle of 
1.5708 radians.

You can specify the angle by entering the value that you want in the Current Connect Points Angles box on the
Place/Edit Connect Points dialog box.



Creating Flexible Symbols with Handles
{button Related Topics,AL("symbol authoring high;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("define handles for symbol how",0,`NOT_FOUND')}

Your symbol might need more control than users can implement by simply selecting the symbol and dragging. 
You can add different types of handles to give the user more control over the symbol.

For more information about handles, click the Related Topics button.



Scales and Symbols
{button Related Topics,AL("symbol authoring high;symbol handles high;paper and model units 
high",0,`NOT_FOUND')} {button How To,AL("symbol authoring how",0,`NOT_FOUND')}

The scale of a template can affect the visual size of a symbol when you drag the symbol into a document. For 
example, the scale for the Architecture (metric) template is set to 1:100 mm on the Sheet Setup dialog box. 
Some symbols that you drag into documents based on that template appear small.



Handles Tab
{button Related Topics,AL("define symbol properties db;symbol handles high",0,`NOT_FOUND')} {button How 
To,AL("define handles for symbol how",0,`NOT_FOUND')}

Tab Options

Scale Handles

Specifies that the symbol displays handles that you can use to scale the entire symbol.            

Mirror Handles

Determines if the symbol displays handles that you can use to mirror the symbol.            

Rotate Handles

Displays handles on the symbol that you can use to rotate the symbol when you place it in a document.            



Define Symbol Properties Dialog Box
{button Related Topics,AL("symbol properties cmd;symbol authoring high",0,`NOT_FOUND')} {button How 
To,AL("symbol authoring how",0,`NOT_FOUND')}

Allows you to create properties for a symbol.    

Dialog Box Tabs

Behaviors Tab

Custom Actions Tab

General Tab

Handles Tab

Icons Tab

Parameters Tab

Standard Actions Tab



General Tab
{button Related Topics,AL("define symbol properties db",0,`NOT_FOUND')} {button How To,AL("associate 
Help file with symbol how",0,`NOT_FOUND')}

Tab Options

Help File

Specifies a special Help document (.HLP) that you can use to display special information about the symbol that 
you create. For example, you could use a Help file to explain different ways to place a door symbol.            

Help Context

Defines a Help context identifier for calling a specific topic in a Help file. The Help file must be compiled with the 
Help context identifier mapped to the Help topic.
Tip    See Visual Basic documentation for information about how to create a Microsoft Windows Help file.



Behaviors Tab
{button Related Topics,AL("define symbol properties db",0,`NOT_FOUND')} {button How To,AL("define text 
driven symbol how;create leader for symbol how",0,`NOT_FOUND')}

Tab Options

Label

Creates a Smart Label. You must click this checkbox to enable a Smart Label to be associated with the attributes
of the object or element to which the label is attached. You can use Smart Labels to define the text attributes for 
a symbol. You can also create a text-driven symbol by clicking this option.

Drop As

Defines what happens to a symbol when it is placed in a document. If you select Symbol, the symbol remains 
and behaves as a symbol when placed in a document. If you select Group, the symbol changes to a group of 
elements or objects when placed in a document. 

If you select Discrete Objects, the symbol breaks up into individual elements and objects that you can edit 
separately. For example, you can select Discrete Objects to define a door symbol that has a text label in the 
center of the door shape. When you place the door symbol in a document, you can move the label to appear 
above the door. 

Step Rotation

Determines the increment for rotating the symbol when you place it while pressing the Left and Right arrow keys 
on the keyboard. If you enter 0 in the box, you cannot rotate the symbol with the Left and Right arrow keys when 
you place the symbol in a document.

Mirror About Target Object

Allows the symbol to mirror about the element or object to which the symbol is being attached. 

Glue to Target Object

Specifies that the symbol moves with the element or object to which the symbol is attached.

Align Parallel with Target Object

Ensures that the symbol aligns parallel to the element or object to which the symbol is being attached, no matter 
where you move the element or object.          

Allow Rotation By Relationships

Allows a symbol to change its orientation on the drawing sheet according to the relationships applied to it. If the 
checkbox is cleared, the symbol does not change its orientation regardless of the way its relationships are 
changed. 

The checkbox is cleared by default. When it is cleared, a symbol maintains its orientation to the drawing sheet 
when you move the symbol or other elements that are related to it. In the following example, the line and symbol 
share a dimensional relationship. The lower end of the symbol is grounded in place with a lock relationship.

 

If you edit the dimensional value of the driving dimension between the line and symbol to modify the position of 
the elements, the symbol does not change its orientation on the drawing sheet. The driving dimension changes 
to a driven dimension that is not to scale, as indicated by the underlined dimensional value.



 

When you set the Allow Rotation By Relationships checkbox, the symbol changes orientation on the drawing 
sheet according to the relationships applied to it. In the example, when you edit the dimensional value of the 
driving dimension to change the position of the elements, the symbol changes orientation on the drawing sheet, 
maintaining the dimensional relationships.

 

Place Leader Line

Places a leader on a Smart Label. This checkbox is available only when you select the Label checkbox. 

Graphics Fit to Text

Allows you to define a symbol that stretches to fit the text height and width of a text box in the symbol, when you 
edit the text. This checkbox is available only when you select the Label checkbox. 

This checkbox only affects parametric symbols or symbols created with one closed shape that is a rectangle, 
circle, or ellipse. The parametric symbol must have two driving dimensions defined as parameters on the 
Parameters tab. These parameters must be identifed as TextHeight and TextWidth.

Double-Click Label Position

Allows you to define where the blinking cursor appears when a user double-clicks a symbol to add a text label to 
it. For example, if you select the Top radio button, the blinking cursor appears above the symbol when a user 
double-clicks it. 



Place/Edit Connect Points Dialog Box
{button Related Topics,AL("place connect points cmd",0,`NOT_FOUND')} {button How To,AL("place 
connect points how;edit connect points how",0,`NOT_FOUND')}

Dialog Box Options

Current Connect Points Angles

Defines the angle at which the connector line attaches to the connect point on the symbol.

Connect Point ToolTip

Specifies the ToolTip that appears when you attach a connector to a connect point on the symbol.



Place/Edit Drop Points Dialog Box
{button Related Topics,AL("place drop points cmd",0,`NOT_FOUND')} {button How To,AL("place drop points 
how;edit drop points how",0,`NOT_FOUND')}

Dialog Box Options

Drop Point ToolTip

Allows you to define the ToolTip that appears on the drop point of the symbol when you place the it. You can use 
a drop point when you are placing a symbol on another symbol. The ToolTip is useful for quickly displaying 
important information that you want a user to know about the symbol. 

For example, you could define a ToolTip for a network card symbol that displays the words Network Card. If you 
attempt to drop the network card symbol near a hub symbol, the ToolTip appears as a visual reminder as to what 
type of symbol you are placing. In drawing network diagrams, you would not want to connect a network card 
symbol to a hub symbol.



Place/Edit Drag Points Dialog Box
{button Related Topics,AL("place drag points cmd",0,`NOT_FOUND')} {button How To,AL("place drag points 
how;edit drag points how",0,`NOT_FOUND')}

Dialog Box Options

Source Drag Order

Allows you to define the order in which the drag points attach to the mouse cursor when dragging the symbol. 
You can cycle through the drag points when dragging the symbol by pressing the Up or Down arrow keys on the 
keyboard. 



SmartText Editor Dialog Box
{button Related Topics,AL("smarttext editor cmd",0,`NOT_FOUND')} {button How To,AL("define text attributes 
for symbol how",0,`NOT_FOUND')}

Places and edits SmartText in a symbol. When you create SmartText in a symbol, you are defining the text 
attributes for the symbol. When the symbol is placed in a document, you can edit the values of the attributes in 
the Attribute Viewer.    Smart Text is typically used to create a Smart Label.

Dialog Box Options

SmartText Editor Box

Specifies the text that appears in the label. You can type in plain text or enter a field by defining information in the
Item, Property, Value, and Format boxes. You must press the Tab on the keyboard to enter the information that 
you type.

Item

Defines the type of object to which the Smart Label is associated.

Property

Names the attribute value pair on the object that you want to label

Value

Identifies the value of the property based on what appears in the Format box.

Format

Identifies the format of the property. The format is any format supported by Visual Basic.

Insert Field

Enters the information that you specified in the Property, Value, and Format boxes into the SmartText Editor 
box.
Tip    If you want to remove a field, you must select the field in the SmartText Editor box and press Delete. Then 
you can define a new field.

Text Font

Determines the format of the characters that you want to appear in the Smart Label. For example, you can select
Arial Bold.



Define Symbol Representation Dialog Box
{button Related Topics,AL("define symbol properties db",0,`NOT_FOUND')} {button How To,AL("define 
symbol representation how",0,`NOT_FOUND')}

Allows you to define several different representations of a symbol in one symbol document. 

For example, you might want to place a valve symbol. But you might want the actuator on the valve to display in 
several different positions. Rather than create several different symbols, you can define representations of the 
same symbol with the actuator appearing in different representations. After you place the symbol in a document, 
you could choose the representation that you want. You can choose it by clicking the right mouse button and 
selecting the representation name from the shortcut menu. The position of the actuator changes based on the 
representation that you selected.
Caution    You must define a group in the symbol document before you can use this dialog box.

Dialog Box Options

Name Column

Displays the name of the representation that you entered in the Name box below. You must select a group in the 
document, enter a name in the Name box, and then click the Add button.          

Object Name Column

Displays the name of the group. The software automatically assigns the name. You cannot change this value.       

Name Box

Allows you to enter the name that you want for the representation. You must select a group in the document 
before you can enter a name for the group in the Name box. This is the name of the representation that appears 
on the shortcut menu when you place the symbol in a document.          

Object Name Box

Displays the name of the group that you selected in the symbol document. The software automatically assigns 
the name of the group. You cannot change this value. 



Icons Tab
{button Related Topics,AL("define symbol properties db",0,`NOT_FOUND')} {button How To,AL("define 
symbol icon how",0,`NOT_FOUND')}

Defines the symbol icon that    you see in the Windows Explorer or the Symbol Explorer.

Tab Options

Automatic

Uses the elements and objects in the current document window to create the symbol. This is handy if you want to
see what the symbol looks like without opening it.

Use Active Sheet

Allows you to save the latest changes in the symbol document to the symbol icon.

Use Bitmaps

Allows you to select a bitmap document to display as the symbol icon. You might want to assign the same icon to
a group of symbols that you are creating. For example, you can assign your company logo to an entire library of 
symbols.

Small

Displays a small icon.

Large

Displays a large icon.



Parameters Tab
{button Related Topics,AL("define symbol properties db;symbols authoring high",0,`NOT_FOUND')}

{button How To,AL("create parametric symbol how;create text driven symbol 
how",0,`NOT_FOUND')}

Automatically displays all the dimensions in the symbol document. You can use this tab to create symbols that fit 
to text. You can also use this tab to define drag handles for resizing when you place the symbol in a document. 
Tip    The information that appears in the Value and Symbol Parameter columns also appears in the Value and 
Name columns of the Attribute Viewer. The Attribute Viewer displays this information when you place or select
a symbol in a document. 

Tab Options

Name Column

Displays the name of a dimensional value in the symbol document.

Value Column

Displays a dimensional value or variable in the symbol document.

Formula Column

Displays a formula for calculating the dimensional value. 

Symbol Parameter Column

Displays the name of the parameter that you assigned in the Symbol Parameter box below the table. 

Name

Displays the name of the dimension or variable that you selected in the table. You can select a row in the table 
by clicking the row. 

If you want to see which dimension in the symbol corresponds to the row that you have selected, you can move 
the dialog box to one side of the document window. The corresponding dimension is highlighted in red.

Symbol Parameter

Displays the parameter that you assign to the dimension. To assign the symbol parameter, you must first click a 
row in the table. You can then type in your own name for a symbol parameter or select one from the dropdown 
list. 

If you want to create a symbol with parametric handles for resizing the symbol, you must assign the following 
symbol parameters to dimensions in the symbol document: Top, Bottom, Right, and Left.
Tip      Driven dimensions cannot have parametric attributes or parametric handles for resizing the symbol. Driven
dimensions appear greyed out. You cannot select a driven dimension in the table.

 



Custom Actions Tab
{button Related Topics,AL("define symbol properties db",0,`NOT_FOUND')} {button How To,AL("define 
shortcut menu for symbol how",0,`NOT_FOUND')}

Allows you to specify processes that you can execute when you select a symbol, click the right mouse button, 
and then click a custom command on the shortcut menu. The command names of the processes that you define 
appear at the top of the shortcut menu. The command can be a .DLL, .OCX, or .EXE file that you created.

For example, if you create a symbol for a heat pump, you might want to place a Calculate Volume command on 
the shortcut menu. The shortcut menu appears when you place the heat pump symbol in a document, select it, 
and click the right mouse button. The Calculate Volume command appears on the shortcut menu. When you click
the Calculate Volume command, a Visual Basic program appears that allows you to calculate the volume of the 
heat pump.          
Tip    You can select a process from the list box to the right of each checkbox. The list boxes to the right of each 
checkbox automatically display a list of .EXE, .DLL, or .OCX contained in a predefined directory: \
SMARTSKETCH\PROGRAM\ADDINS_BIN\SYMBOL CONTENT\*.*. You can also type the ProgID of registered
files directly in the list box and press Enter. The ProgID is assigned when you create the file. See the 
documentation for Visual Basic for more information about ProgID's.

Tab Options

Name

Specifies the name of the process that appears on the shortcut menu. 

Command

Specifies the filename of the .DLL, .OCX, or .EXE for the command. You can browse to find the file. 



Standard Actions Tab
{button Related Topics,AL("define symbol properties db",0,`NOT_FOUND')} {button How To,AL("run program 
from symbol how",0,`NOT_FOUND')}

Allows you to define processes that can execute when you place a symbol in document and then perform actions
on the symbol, such as double-clicking it, dragging and dropping it, or clicking the Properties command on the 
Edit menu.
Tip    You can select a process from the list box to the right of each checkbox. The list boxes to the right of each 
checkbox automatically display a list of .EXE, .DLL, or .OCX contained in a predefined directory: \
SMARTSKETCH\PROGRAM\ADDINS_BIN\SYMBOL CONTENT\*.*. You can also type the ProgID of registered
files directly in the list box and press Enter. The ProgID is assigned when you create the file. See the 
documentation for Visual Basic for more information about ProgID's.

Tab Options

On Drop

Specifies a process that executes when you drag a symbol in a document. You can select a process from the list 
box. 

On Double-Click

Specifies a process that executes when you double-click a symbol in a document. You can select a process from
the list box. 

On Right Click

Specifies a process that executes when you pass the mouse cursor over a symbol in a document and then click 
the right mouse button. You can select a process from the list box. 

On Modify

Specifies a process that executes when you modify a symbol in a document. You can select a process from the 
list box. 

On Property

Specifies a process that executes when you select a symbol in a document and click the Properties command 
on the Edit menu. You might want to select this and display a Properties dialog box that you created, rather than
the one that is delivered with the software. You can select a process from the list box. 



active style
The style that is used when you draw an element or copy it. You can change the active style to one of the styles 
listed in the Style box on the ribbon bar.



angular dimension
A dimension that measures the sweep angle of an arc, the angle between an origin and a line, the angle between
two lines, or the angle among three key points.



annotation
Text, graphics, or symbols that give you more information about a drawing.

 
(A) Leader line
(B) Break line
(C) Terminator
(D) Annotation

aspect ratio
The ratio of width to height of geometry.



associative
A condition in which an element is related to another element.



associative dimension
A dimension that is updated when the measurement of the element it refers to changes.



associativity
The concept that embraces all techniques for capturing design intent, including variational design, parametric 
design, and feature-based modeling.



background sheet
A component of a drawing sheet. The background sheet is used for graphics that you want to display on more 
than one drawing, such as a border, title block, logo, or raster background picture (watermark). A background 
sheet can be displayed and printed along with any working sheet it is attached to.



balloon
A type of annotation that consists of a closed shape that contains text. A balloon defines individual parts in 
assemblies and    field notes on drawings.



baseline
1 The area between a line and text. 
2 The process that freezes a document from any further modification. When you baseline a document, you also 

freeze any documents that are linked to the baselined document.



callout
A type of annotation that consists of a text box with a leader.



center point
The middle of a circle or arc.



centerline
An annotation on a mechanical drawing that marks the center position of a hole or other feature on a part.



chained dimension group
A series of dimensions that are arranged in a straight line. A chained dimension group measures locations from 
element to element.



chamfer
A corner that has been cut at an angle.



closed curve
A curve whose end points meet. A closed curve encloses an area.



closed element
An element whose end points meet. A closed element encloses an area.



coincident relationship
A relationship that specifies that two points have the same location.



colinear relationship
A relationship that ensures that a set of identified points or lines lie in a straight line.



command
A tool designed to complete a single task, such as create an arc or a line.



compound document
A document that contains files with various formats. For example, a document composed of AutoCAD and 
MicroStation documents.



container
A document that contains documents created with other applications. Through OLE you can access the 
application that created the document and link and embed a document created by another application.



cross hatching
An annotation on a drawing that designates the fill area of a model; a fill.



coordinate dimension group
A group of dimensions that measure locations from a common origin.



curve
An element type that is not linear.



cusp node
A type of vertex on a curve. A curve with a cusp node bends sharply at the node. A handle can be attached to a 
cusp node for editing. 



design data
Real world objects that you draw in a computer drawing. Typically these items must be scaled in the drawing 
sheet.



diameter dimension
A dimension that measures the diameter of a circle or arc.



dimension
A control that assigns and maintains a dimensional value to an individual element or establishes a dimensional 
relationship among multiple elements. A label with text, lines, and arrows graphically represents a dimension.



dimension axis
An axis for dimension orientation that you define by selecting a line. You can place linear dimensions that run 
parallel or perpendicular to the axis. By default, dimensions are placed horizontally or vertically.



dimension group
A series of dimensions. You can place a chained dimension group, a coordinate dimension group, or a stacked 
dimension group.



dimensional value
The text that indicates the value of a dimensional measurement, such as distance, length, or angle.



display filter
A tool that allows you to display selected layers in a drawing.



document data
Annotations, such as dimensions, text boxes, callouts, balloons, and centerlines, that are used to describe 
design data.



drawing sheet
The area of the application window that you draw in. There are two types of drawing sheets: working sheets and 
background sheets. Both types of sheets display a border, called a sheet outline, that shows the size, orientation,
and printable region of the current sheet.



drawing sheet tab
Drawing sheet tabs are located at the bottom of the drawing sheets in your document. There is a drawing sheet 
tab for each drawing sheet.

The drawing sheet tabs allow you to change the active drawing sheet, create new drawing sheets, delete 
drawing sheets, and copy drawing sheets. 



drawing tool
A tool that helps in the process of creating, modifying, or manipulating elements. For example, PinPoint and 
SmartSketch.



drawing view
A 2-D representation of a 3-D part or assembly. You can manipulate drawing views to display the part or 
assembly on a drawing sheet at a specified scale and orientation.



driven dimension
A dimension with a value that depends on the value of other dimensions or elements.



driving dimension
A dimension with a value that controls the size, orientation, or location of an element.



edge point
A location on the boundary of an element. For example, edge points can be used to define the circumference of 
a circle.



element
A simple, selectable unit in a drawing. You can select geometric elements, dimensions, annotations, objects 
placed in the drawing through OLE, and so forth. The type of element that can be selected is determined by 
command context.



embed
A method for inserting information from a source document into the active document. Once embedded, the 
information becomes part of the active document; if changes are made to the source document, the updates are 
not reflected in the active document.



end point
The end of an element.



equation
The algebraic relationship between dimensions and/or numeric properties.



file locking
The ability to prevent updates to a document.



fill
A pattern or solid color placed inside a closed boundary.



free space
An area that is not on or inside an element or object on a drawing sheet.



FreeForm
A drawing tool that allows you to use the mouse to sketch curves. As you press and hold the mouse button and 
drag the pointer across the drawing sheet, a rough sketch of your design appears. When you release the mouse 
button, the software turns your sketch into smooth curves.



FreeSketch
A drawing tool that allows you to use the mouse to sketch lines, arcs, circles, and rectangles. As you press and 
hold the mouse button and drag the pointer across the drawing sheet, a rough sketch of your design appears. 
When you release the mouse button, the software recognizes the shapes in your sketch and turns them into a 
precise drawing.



from point
The starting point for an action. For example, when you rotate elements, the from point determines where you 
want the rotation to begin.



geometric element
A point, line, arc, circle, or other simple geometry unit.



group
A collection of objects that you can manipulate as a single item. 



handle
Solid or hollow squares that are displayed at significant positions on a geometric element when you select the 
element. You can manipulate an element with a handle.



help lines
The dashed coordinate axes displayed by PinPoint. The help lines extend from the target point to the current 
pointer location. They are dynamically updated as you move the cursor. You can turn the help line display on or 
off.



horizontal relationship
A relationship that specifies that the end points of a line, or two key points, are level with each other along the x 
axis.



image
A raster image, which can be a .TIFF, .GIF, .JFIF, .BMP, .COT, .CIT, or .RLE document.



intent zone
A quadrant divided into four pie-shaped wedges that determines the behavior of an element's relationship to 
either a circle or arc. Intent zones allow you to specify where you want to draw an element in relation to an arc or
circle. For example, as you draw an arc, you can change the arc's direction by moving the cursor to a different 
position within the intent zone. You can define the size of the intent zone by specifying the number of pixels in it.



key point
A recognizable point on an element. Key points include vertices, mid points, center points, and so forth.



layer
A logical grouping of elements or objects on a drawing sheet. You can have several layers in a drawing sheet.



linear dimension
A dimension that measures the linear distance between two or more elements, the length of a line, or the arc 
length of an arc.



link
The connection between an inserted image or object, known as the source document, and the active document. 
Changes made in the source document are reflected in the active document when the active document is 
updated.



locate zone
A circular area at the center of the crosshair cursor or at the end of the arrow cursor. The locate zone specifies 
how close the cursor must be to an element you want to recognize or select. You can define the size of the locate
zone with the SmartSketch command on the Tools menu.



lock
A relationship that makes the position of an element or key point, or the value of a driving dimension, stationary.



macro
A sequence of actions or commands that can be named and stored. When you run the macro, the software 
performs the actions or runs the commands. You can create the macros in Visual Basic or other OLE-aware 
programming applications. Some of the OLE-aware programming applications are VBA (inside of Excel), Visual 
C++ Delphi, Visual Basic, and so forth.



midpoint
The middle point of an element.



mirror axis
The line about which the selection set is mirrored. When you select the Mirror command, the software displays 
horizontal and vertical mirror axes that go through the center of the selection set. You can display other mirror 
axes by locating linear elements.



modification
The act of changing the size, position, or orientation of an element by modifying the element or its handles.



pointer
The screen device that you use to select elements, commands, and other items in the software.



nested symbol
A symbol that is placed into a document which is then placed as a symbol in another document. Symbols that are
public display across different documents. Symbols that are private only display in the first document.



node
A vertex on a curve. An exterior node has one handle, and an interior node has two handles. A curve can have 
one or more smooth, cusp, or symmetric nodes. The type of node a curve has affects how you modify the curve.



object
1 Information that can be linked or embedded into an OLE-compliant product.
2 A group of elements that represent a real-world object. An object can also be made up of a single element.



OLE
The way Microsoft uses the Common Object Modeler (COM).    It is a mechanism to make data work 
independently.



open curve
A curve whose end points do not meet.



open element
An element whose end points do not meet.



parallel relationship
A relationship that specifies that the orientation of one line is identical to that of another line.



perpendicular relationship
A relationship that specifies that the orientation of a line or end point of an arc is at a right angle to the orientation
of another line, arc, circle, or curve.



PickQuick
An automatic software tool that allows you to select an element when several elements overlap. When you place 
the pointer over a set of overlapping elements, three small circles appear at the bottom right of the cursor. When 
you click, a small toolbar with the number of selectable elements appears. You can move the pointer over the 
numbers; and, when the element that you want highlights, you can click on the corresponding number to select it.



PinPoint
A tool that allows you to place, move, and modify elements with precision, relative to a reference point.



precision input
The method of defining the position of a point in space by using precise coordinates or by using a value to 
describe the point’s position from the coordinates of another point.



primary axis
The axis that defines the rotation angle of the ellipse. Zero degrees is horizontal to the x axis; the angle 
increases in the counterclockwise direction. The primary axis is defined first and can be shorter than the 
secondary axis.



property
A unique characteristic of an element, object, symbol, or document. You can display document properties in the 
Windows Explorer or by clicking Properties on the File menu or Edit menu. 

Properties for elements or objects have three different types, as defined on the Properties dialog box: 
Style properties, as specified on the Format tab. Style properties affect the format of the element.                      
Size properties, as specified on the Info. Size properties affect characteristics of the element, such as the 

length. 
User-defined properties, as created on the User tab. User-defined properties are usually in the form of a text

notation, such as cost, manufacturer, and so forth You can change user-defined properties, but these changes have 
no affect on the appearance of the element or object.

For example, a valve symbol's style properties can include color, line style, and width. Other user-defined 
properties stored with the symbol can include the manufacturer, cost, or material. User-defined properties are 
displayed in the Attribute Viewer when you select the valve symbol. 



radial dimension
A dimension that measures the radius of an arc, circle, ellipse, or curve.



reference file
Any file not native to SmartSketch that is linked or embedded and used for reference information. You click 
Insert > Object to link or embed a reference file, or you can drag or drop it with Windows Explorer.



relationship
A condition that exists for an individual element or between elements. You can establish relationships as you 
place new elements or between elements already on the drawing sheet. If Maintain Relationships is set, then 
the relationship controls the modification behavior of the related elements. For example, if two lines have a 
parallel relationship, they remain parallel when one of the lines is moved.

SmartSketch recognizes potential relationships as you draw. Relationship handles are placed on related 
elements to represent maintained relationships.



relationship handle
A graphic used to represent a geometric relationship between elements, key points, and dimensions, or between 
key points and elements. The relationship handle shows that the designated relationship is being maintained.

Command Relationship Handle

Colinear

Connect

 

Concentric

Equal

Horizontal/Vertical

Tangent

Symmetric

Parallel

Perpendicular

Lock

relationship indicator
A graphic that is displayed at the pointer when the software recognizes a SmartSketch relationship.

Relationship Relationship Indicator

Endpoint

Midpoint

Intersection

Horizontal

Vertical

Point On Element

Perpendicular

Parallel



Tangent

Center

rotation angle
The angle between 0—180 degrees that an element is rotated in either direction. Zero degrees is horizontal to 
the x axis; the angle increases in the counterclockwise direction. 



rotation angle
The angle at which the rectangle is oriented. Zero degrees is defined by the positional angle. The angle 
increases in the counterclockwise direction.



rotation axis
A temporary line that shows the rotation angle with respect to the rotation reference axis. Zero degrees is defined
by the positional angle; the angle increases in the counterclockwise direction.



rotation reference axis
A temporary line defined by the center of rotation and the rotation from point. Zero degrees is horizontal; the 
angle increases in the counterclockwise direction. The rotation angle is measured from this line.



scale origin
The starting point from which an object is scaled along the x and y axes.



secondary axis
The axis that is perpendicular to the primary axis of an ellipse. The secondary axis is defined after the primary 
axis and can be longer than the primary axis.



Select Tool
A tool that allows you to select elements before you run a command on them. 



selection set
A single selected object or a group of selected objects.



share embed
A document copied directly into a drawing. When you embed the same document more than once in the same 
document, the document elements are copied each time. When you share embed the same document more than
once in the same document, the documents are not copied each time. Instead, the other documents reference 
the initial placement of the document.



shortcut menu
A menu that gives you quick access to commands that are related to the item you are working with. The 
commands available on the shortcut menu depend upon the selected element or active command. To activate 
the shortcut menu, click the right mouse button.



sketch
The process of creating a rough drawing that approximates the size or shape of a real-world object.



smooth node
A type of vertex on a curve. A curve with a smooth node has a different curvature on each side of the node. The 
start point and end point of a curve is always a smooth node. A handle can be attached to a smooth node for 
editing.



source document
A document that provides data, graphics, or other information to another document through a link.



stacked dimension group
A series of individual dimensions that are arranged at different levels from the smallest value to the largest. A 
stacked dimension group measures locations from a common origin.



style
1 The appearance of geometry and annotations on the drawing sheet. For example, an element's color and line 

weight, the font used in a text box, and so forth. 
2 A collection of formats or properties that you name and store as a group. When you apply a style to a selected

item, the software applies all the formats or properties in the style to the element. The style types include: fill, 
dimension, line, and text.



sweep angle
The angle that defines the length of an arc.



symbol
A document placed in a drawing. You can override and edit the properties and style of the symbol. A document 
can be linked, or    embedded.



symmetric node
A type of vertex on a curve. A curve with a symmetric node has the same curvature on each side of the node. A 
handle can be attached to a symmetric node for editing.



tangent relationship
A relationship between an arc or circle and another geometric element. The elements share a common point that
is not intersecting.



target point
The origin for coordinate measurements displayed by PinPoint. You can position the target point anywhere on 
the drawing sheet.



template
A default set of properties that defines what a new document will look like. You can use a template to set 
standards for a group of users or to define your own preferences.



terminator
A graphic symbol, such as an arrow or dot, placed at the end of a leader.



text box
A rectangular element that contains text or symbols; you can place text boxes on drawing sheets.



to point
The ending point for an action. For example, when you rotate elements, the to point determines where you want 
the rotation to stop.



toolbar
Toolbars are graphic menus with buttons that allow you to quickly access commands. You can define custom 
toolbars or use the toolbars delivered with the software.



tools
A set of commands that can be activated from a menu, toolbar, or keyboard shortcut. Tools are self-contained, 
designed for specific tasks, and can be used in any compatible environment.



user property
A unique characteristic of an element or object in a file. You can assign unique values to an element or object 
with the Properties command on the Edit menu.



variable
A value that can be referenced and changed.



vertex
The highest point or apex of a figure, the intersection of lines or curves, or the end point of an element.



vertical relationship
A relationship that specifies that the end points of a line, or two key points, are level with each other along the y 
axis.



window
An area defined by a standard border and buttons that is used to display information in an application.



wireframe element
A 2-D, graphic representation of simple geometry; wireframe elements include points, lines, circles, arcs, conic 
curves, freeform curves, and composite curves.



working sheet
A component of a drawing sheet. The working sheet is where you create design data and document data. You 
can apply a scale to document and design data and attach a background sheet to the working sheet.





style type
A type of style that is based on the type of element that the style affects.    The style types include: fill, dimension,
line, and text.



style resource document
Any .igr or .RSC document that contains styles native to that document. A template or document can reference 
several style resource documents. These styles are copied into the current document when the styles are 
actually applied to elements or annotations in the document.





attribute
A user-defined property or parameter assigned to an element, object, or document. A parameter refers to 
variables in a symbol document that drive dimensional values. You can display attributes with the Attribute 
Viewer.



parameter
An attribute assigned to an element or object, usually a numerical value representing a dimension. A parameter 
is a mechanism to change a property. A parameter refers to variables in a symbol document that drive 
dimensional values. Parameters appear as bold characters in the Attribute Viewer. 



Smart Label
A label that is associated to the attributes on an element or object. Smart Labels are created with the tools on the
Symbol Authoring Tools toolbar.



bearing
A determination of position to refer to an angle



azimuth
A horizontal direction expressed as an angle, progressing from a fixed point, based on a circle.



base bearing
Direction (North, South, East, West) bearing to refer to an angle. 



direction
Clockwise or counterclockwise indicator for the angle bearing.



isometric drawing
A drawing represented as the object or element is actually projected on a plane of projection: a 3D drawing 
represented in 2D.



parametric symbol
A symbol that contains geometry constrained together using relationships, with driving dimensions that are 
defined as adjustable parameters.



user-defined property
A type of property created on the User tab of the Properties dialog box for the element or object. User-defined 
properties are usually in the form of a text notation, such as cost, manufacturer, and so forth You can change 
user-defined properties, but these changes have no affect on the appearance of the element or object.

For example, user-defined properties stored with a valve symbol can include the manufacturer, cost, or material. 
User-defined properties are displayed in the Attribute Viewer when you select the valve symbol.



hyperlink
Colored and underlined text or a graphic that you click to go to a file, a location in a file, an HTML page on the 
World Wide Web, or an HTML page on an intranet. Hyperlinks can also go to Gopher, telnet, newsgroup, and 
FTP sites.





Place Drag Points on a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Place/Edit Drag Points button. 

Tip    All the drag points appear in the document.
 
3 In the document, click to place a drag point.
4 On the Place/Edit Drag Points dialog box, enter the drag point order that you want. For example, if you want the

first drag point that you place to be the first drag point to which the cursor attaches, enter a 1. 

{button Related Topics,AL("place drag points cmd;place drag points db",0,`NOT_FOUND')}



Edit Drag Points on a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Place/Edit Drag Points button. 

Tip    All the drag points appear in the document.
 
3 In the document, select the drag point that you want to edit. 
4 On the Place/Edit Drag Points dialog box, set the options that you want. 

{button Related Topics,AL("place drag points cmd;place drag points db",0,`NOT_FOUND')}



Place Drop Points on a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Place/Edit Drop Points button. All the drop points appear in 

the document.
 
3 Click an element in the document to place a drop point. 
4 On the Place/Edit Drop Points dialog box, set the options that you want. 

{button Related Topics,AL("symbol authoring high;place drop points cmd;place drop points 
db",0,`NOT_FOUND')}



Add Commands to the Shortcut Menu for a Symbol
Before you can take the following steps, you must create a .DLL, .OCX, or .EXE in Visual Basic. You must place 
the executable file in the following directory:

<Drive Letter>:\PROGRAM FILES\SMARTSKETCH\PROGRAM
\ACTIONOVERRIDES\CUSTOMACTIONS\
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Symbol Properties button.
 
3 On the Custom Actions tab in the Name box, type the command name that you want to appear on the shortcut 

menu.
Tip    The shortcut menu appears when you select the symbol in a document and then right click.

4 In the Command box, select the name and path of the .DLL, .OCX, or .EXE file. This command runs when you 
place a symbol and select the command on the shortcut menu.

Tips
You can also add commands to the shortcut menu by setting options on the Standard Actions tab.

{button How?,AL("run program from symbol how",0,`NOT_FOUND')}

{button Related Topics,AL("custom actions tab db;symbol properties cmd",0,`NOT_FOUND')}



Define Handles for a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Symbol Properties button.

 
3 On the Handles tab, select the type of handles that you want.

Tip    For more information about handles, click the Related Topics button.

{button Related Topics,AL("handles tab db;define symbol properties db;symbol properties 
cmd",0,`NOT_FOUND')}



Edit Drop Points on a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Place/Edit Drop Points button.

Tip    All the drag points appear in the document.
 
3 In the document, select the drop point that you want to edit. 
4 On the Place/Edit Drop Points dialog box, set the options that you want. 

{button Related Topics,AL("symbol authoring high;place drop points cmd;place drop points 
db",0,`NOT_FOUND')}



Redefine the Origin of a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Symbol Origin button.

 
3 Click a point to redefine the origin of the symbol. The symbol origin is the point that the mouse cursor uses to 

drag the symbol into a document.

{button Related Topics,AL("symbol origin cmd",0,`NOT_FOUND')}



Run a Program That You Created from a Symbol
Before you can take the following steps, you must create a .DLL, .OCX, or .EXE in Visual Basic. You must place 
the executable file in one of the following directories, depending on what action that you want to use to start the 
executable file. For example, if you want a special process to run when you drop the symbol in a document, you 
must place the executable file in the DROPACTIONS subdirectory.

<Drive Letter>:\PROGRAM FILES\SMARTSKETCH\PROGRAM
\ACTIONOVERRIDES\DOUBLECLICKACTIONS\

<Drive Letter>:\PROGRAM FILES\SMARTSKETCH\PROGRAM
\ACTIONOVERRIDES\DROPACTIONS\

<Drive Letter>:\PROGRAM FILES\SMARTSKETCH\PROGRAM
\ACTIONOVERRIDES\MODIFYACTIONS\

<Drive Letter>:\PROGRAM FILES\SMARTSKETCH\PROGRAM
\ACTIONOVERRIDES\PROPERTYACTIONS\

<Drive Letter>:\PROGRAM FILES\SMARTSKETCH\PROGRAM
\ACTIONOVERRIDES\RIGHTCLICKACTIONS\

1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Symbol Properties button.

 
3 On the Standard Actions tab, select the options that you want. For example, if you want a special process to 

run when you drop the symbol in a document, you must select the On Drop box. Then, you can select the name 
of the .DLL, .OCX, or .EXE file from the list box beside the On Drop checkbox.

Tips
If you want to create special commands for the shortcut menu that appear when you select the symbol in a 

document, you can set options on the Custom Actions tab.
{button How?,AL("define shortcut menu for symbol how",0,`NOT_FOUND')}

{button Related Topics,AL("symbol properties cmd;define symbol properties db",0,`NOT_FOUND')}



Create a Leader for a Smart Text Label
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click the Symbol Properties button. 

 
3 On the Behaviors tab, click Label.
4 Click Place Leader Line.

{button Related Topics,AL("behaviors tab db;symbol properties cmd",0,`NOT_FOUND')}



Create a Parametric Symbol
Caution    To create a parametric symbol, you must take the following steps in the order that they are listed. 
Before you begin, select the Maintain Relationships option on the Tools menu.

 

Create a Symbol with Driving Dimensions
1 Click File > New.
2 Draw the elements that you plan to use in the symbol.

{button How?,AL("circle how;rectangle how;ellipse how",0,`NOT_FOUND',`howto')}
3 On the Main toolbar, click the Dimension button.

4 On the Dimension toolbar, click the SmartDimension button.

Caution    On the ribbon bar, make sure that the Driving/Driven button is set, if you have turned it off when 
previously placing dimensions. 

Tip    You can use any of the dimension buttons on the Dimension toolbar to place your dimensions. 
Caution    Do not use the Angle button on the ribbon bar if you want users to rotate the symbol.

5 Click an element.
6 Click to place a driving dimension.

Tip    Repeat this step to place up to four driving dimensions. These dimensions are used to create the 
parametric handles for the height and width of the parametric symbol. You can use up to four dimensions for 
the parametric handles.

7 Select the elements that you want for the symbol and create a symbol.
{button How?,AL("create symbol how",0,`NOT_FOUND',`howto')}

Set Up Parametric Handles
1 Open the symbol document that you just created.
2 On the Symbol Authoring Tools toolbar, click the Symbol Properties button. The Parameters tab on the 

Define Symbol Properties dialog box automatically displays the driving dimensions in the symbol document. 
 
3 On the Parameters tab, select a driving dimension in the table by clicking the appropriate row. For example, for 

the dimension 30.000 mm, you would want to select the row that displayed the value 30.000 mm.



Tip    If you move the Define Symbol Properties dialog box to one side of the document window, you can see
the dimension that you selected on the Parameters tab highlighted in the document.

4 In the Symbol Parameter box, select a row to apply Top, Bottom, Left, or Right to the row. For example, for the
dimension 30.000 mm, you would want to select Right. 
Tip    You can also click Apply. 
Selecting Top, Bottom, Left, or Right determines the place on the finished symbol where the yellow 
parametric handles appear. For example, if you select Top and Left, the parametric handles appear at the top
center and left center of the symbol range box.
Tip    While creating a parametric symbol that grows when text is added, you must identify the two primary 
dimensions as TextHeight and TextWidth, instead of selecting Top, Bottom, Left, or Right.

5 Repeat the previous two steps as necessary for the number of handles that you want to appear on the symbol. 
You can identify up to four parametric handles. In the current example, for the dimension 20.000 mm, you would 
want to select Bottom.

6 Click File > Save. 
This procedure creates drag handles that appear as square yellow handles on the symbol's range box. You 
can place the symbol and use the drag handles to move the symbol in the document. In a new document, 
drag the symbol that you created.

Tips
The parametric handles do no support grid snap. You cannot define a step distance. Parametric handles 

change the represented dimension by the precision units defined on the Units tab of the Properties dialog box. You 
can access the Properties dialog box by clicking Properties on the File menu.                                                

{button Related Topics,AL("create text driven symbol how;variable table db;create symbol cmd;define symbol 
properties db;define symbol properties db",0,`NOT_FOUND')}



Create a Symbol with a Fill for Masking
Before you begin, create a symbol with the outermost elements on a separate layer. If the symbol has already 
been drawn, just select the elements that form the outer edges of the symbol and move the select set to a new 
layer called Boundary.
1 Turn off all other layers in the symbol document, except the layer containing the boundary of the symbol.
            How?  

2 Create a layer named Fill. This helps to organize the elements that make up a symbol.
            How?  

3 With the Fill layer active and the Boundary layer displayed, click the Fill button on the Draw toolbar.
4 On the Fill ribbon bar, change the style to Solid, and then select the blank color from the pallet. 

Tip    The blank color is located in the lower right corner of the standard color pallet.
5 Then, click inside the bounding line elements to place the solid blank colored fill. You can see the blank fill when 

grid display is turned on. 
6 Click to select the fill. 
7 With the fill selected, click the Send To Back button on the Change toolbar. This pushes the blank fill to the back

of the symbol and allows the detailed elements that make up the interior of a symbol to display on top of the 
blank fill. 

8 Turn on the display of the other layers containing interior graphics.
9 Save the symbol. 

{button Related Topics,AL("fills and symbols high",0,`NOT_FOUND')}



Define a Text-Driven Symbol
Caution    To create a symbol that resizes to fit any text, you must take the following steps in the order that they 
are listed. Before you begin, select the Maintain Relationships option on the Tools menu.

For a Symbol with a Circle, Rectangle, or Ellipse
1 In a symbol document, draw a rectangle, circle, or ellipse.

{button How?,AL("circle how;rectangle how;ellipse how",0,`NOT_FOUND',`howto')}
Caution    You cannot use connected elements such as a series of arcs or lines. 

2 On the Draw toolbar, click Text Box.

3 Click the center of the rectangle, circle, or ellipse to place a text box.
4 On the Draw toolbar, click the Select tool and select the text box.

5 Click Edit > Properties.
6 On the Properties dialog box, set the options that indicate the directional flow for text if you add characters to 

the text box.    You can specify the direction by the options that you click.
For example, if you want the text in the rectangle, circle, or ellipse to grow from the center of the element, you 
can set the following options:

On the Info tab, set Horizontal in the Text Alignment group to Center.
On the Info tab, set Vertical to Center.
On the Paragraph tab, set Alignment to Center.

7 On the Symbol Authoring Tools toolbar, click the Symbol Properties button.
 
8 On the Behaviors tab, select the Label checkbox.
9 Select the Graphics Fit to Text checkbox.

For a Parametric Symbol
1 Create a parametric symbol.

{button How?,AL("create parametric symbol how",0,`NOT_FOUND',`howto')}
Tip    While creating the parametric symbol, you must identify two primary dimensions as TextHeight and 
TextWidth.

2 Open the new symbol document that you just created.
3 On the Draw toolbar, click Text Box.

4 Click the center of the symbol to place a text box.
5 On the Draw toolbar, click the Select tool and select the text box.

6 Click Edit > Properties.
7 On the Properties dialog box, set the options that indicate the directional flow for text if you add characters to 

the text box.    You can specify the direction by the options that you click.
For example, if you want the text in the rectangle, circle, or ellipse to grow from the center of the element, you 
can set the following options:

On the Info tab, set Horizontal in the Text Alignment group to Center.
On the Info tab, set Vertical to Center.
On the Paragraph tab, set Alignment to Center.

8 On the Symbol Authoring Tools toolbar, click the Symbol Properties button.
 
9 On the Behaviors tab, select the Label checkbox.
10 Select the Graphics Fit to Text checkbox.

Tips
If you want to create a symbol that has text associated to attributes, you can define a Smart Label that 

contains Smart Text for the symbol. Smart Labels that contain Smart Text are associated with text attributes for the 
symbol. When you attach a symbol with a Smart Label to an element or object in a document, the symbol attributes 



assume the values of the element attributes. If the element or object does not have attributes, then the element or 
object assumes the attributes on the symbol.

{button Related Topics,AL("create parametric symbol how;define symbol properties db",0,`NOT_FOUND')}



Define Symbol Properties
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click Symbol Properties.

 
3 On the Define Symbol Properties dialog box, select the properties that you want for the symbol.

Tip    For more information about each tab on the dialog box, click the Related Topics button.

{button Related Topics,AL("symbol properties cmd;define symbol properties db;symbol authoring 
how",0,`NOT_FOUND')}



Define Connect Points for a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click Place/Edit Connect Points. All the connect points appear in the 

document.
 
3 In the document, click to place a connect point.
4 On the Place/Edit Connect Points dialog box, set the angles at which the connector should attach to the 

connect point.
5 In the Connect Point Tooltip box, enter the text that you want for a Tooltip. The Tooltip appears as a user draws 

a connector to a connect point on the symbol.

{button Related Topics,AL("place connect points cmd;place connect points db",0,`NOT_FOUND')}



Edit Connect Points on a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click Place/Edit Connect Points. 

If any connect points have been defined, they automatically appear in the document.
 
3 In the symbol document, select a connect point that you want to edit.
4 On the Place/Edit Connect Points dialog box, set the angle in radians at which a connector should attach to the

connect point.
5 In the Connect Point Tooltip box, enter the text that you want for a Tooltip. The Tooltip appears as a user draws 

a connector to a connect point on the symbol.

{button Related Topics,AL("place connect points cmd;place connect points db",0,`NOT_FOUND')}



Define Several Representations of a Symbol in One Document
Before you begin, you must create a symbol document that contains all the different elements that you would 
want to show up as several different versions of the same symbol. For example, if you want a symbol to appear 
as either a box, triangle, or circle, you must draw the box, triangle, or circle in the document and create a symbol.
You can add new elements and further modify the symbol at any time during the next steps.
{button How?,AL("create symbol how",0,`NOT_FOUND',`howto')}

Tip    You cannot include the same element in different representations. You must create a copy of that element 
in the document to allow it to appear in different representations.
1 Click File > Open to open a symbol document (.sym).
2 Select two or more elements that you want to show up as a representation of the symbol.

Tip    You cannot select an element that is already a member of a group.
3 On the Change toolbar, click the Group button.

Caution    You cannot place one element in more than one group. To include the same element in different 
representations, you must copy the element and include it in a different group.

4 Define a separate group for each representation that you want to save in the symbol document.

 
Tip    You can create the representation more easily if you keep each group in a separate section of the 
document at this point in the procedure. Do not allow the groups to overlap. You can define a common origin 
for all the groups later in the procedure.

5 On the Symbol Authoring Tools toolbar, click Symbol Representation.
 
6 Select a group that you want to appear in the representation. The name of the group automatically appears in the

Object Name box on the Define Symbol Representation dialog box. This name is automatically generated by 
the software.

7 In the Name box, enter the name that you want. This is the name of the representation that appears as a 
command on the shortcut menu when you place the symbol in a document.

8 Click the Add button to enter the name in the table.
Tip    The order in which the names appear in the table is the order in which the commands appear on the 
shortcut menu. You can insert or delete names from the table at any time. For example, you can enter the 
following names in the table in the following order so that they appear in a certain order on the shortcut menu 
for the symbol:
Name Object Name

Flanged Globe Group 235
Screwed Globe Group 236
Bell Spigot Globe Group 237
Welded Globe Group 238
Soldered Globe Group 239

 
9 Repeat these steps for each representation that you want to appear on the shortcut menu.
10 Select each group and move it to a position that is on top of the other groups. You should position each group so 

that they share a common origin.
Tip    You can adjust the symbol origin by clicking the Symbol Origin button on the Symbol Authoring Tools 
toolbar.



 
11 Click File > Save.

Tip    You should close the symbol document before dragging and dropping the symbol into a document.

Tips
After saving the symbol, you should test the different representations that you defined. Close the symbol. 

Drag the symbol from the Symbol Explorer into a new document. Select the symbol and click the right mouse 
button. Make sure that the names of the representations appear on the shortcut menu.
 

You can change the name of a group object by clicking a row in the table, entering a new name in the Name
box, and clicking the Modify button.

The group object listed first in the table is the default thumbnail for the symbol.

{button Related Topics,AL("define symbol representation db;symbol representation cmd",0,`NOT_FOUND')}



Define Smart Text Attributes for a Smart Label
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click SmartText Editor.

 
3 Enter the information that you want into the Property, Value, and Format boxes. 
4 Click Insert Field.

Tips
If you want to remove a field, you must select the field in the SmartText Editor box and press Delete. Then 

you can define a new field. You cannot select individual characters between the angle brackets of the SmartText 
field. You can select only the entire field.                                                

{button Related Topics,AL("smarttext editor cmd;smarttext editor db",0,`NOT_FOUND')}



Define an Icon for a Symbol
1 Open a document with an .sym extension.
2 On the Symbol Authoring Tools toolbar, click Symbol Properties.
3 On the Icons tab, set the options that you want.

{button Related Topics,AL("define symbol properties db;icons tab db;symbol authoring high",0,`NOT_FOUND')}



Edit Smart Text Attributes for a Symbol
1 Open a document with an .sym extension.
2 Double-click a label in the symbol.
3 Type the text that you want and press Enter.

Tips
If you place a symbol with a Smart Label in a document, you cannot select the Smart Label and open it for 

editing like most symbols. You must create a new Smart Label.

{button Related Topics,AL("symbol authoring high;smarttext editor cmd;smarttext editor db",0,`NOT_FOUND')}




